Automation Engine

Jobs
# Contents

1. **Job Basics** .................................................................................................................................................................................. 4
   1.1. The Job Concept ............................................................................................................................................................................. 4
   1.2. Types of Jobs .................................................................................................................................................................................. 5
   1.3. The Job Views ................................................................................................................................................................................ 6
   1.3.1. General Job Views .................................................................................................................................................................... 6
   1.3.2. Job View Filters ........................................................................................................................................................................ 8
   1.3.3. Job Specific View .................................................................................................................................................................... 10
   1.4. The Job Menu ............................................................................................................................................................................... 11

2. **Creating a Job** .................................................................................................................................................................................. 13

3. **Job Setup Parameters** ....................................................................................................................................................................... 15
   3.1. Job tab ......................................................................................................................................................................................... 15
   3.2. Customer tab .............................................................................................................................................................................. 17
   3.3. Inks tab ....................................................................................................................................................................................... 18
   3.4. Parameters tab ........................................................................................................................................................................... 19
   3.4.1. Creating and Modifying a Custom Job Parameter .................................................................................................................. 20
   3.4.2. Loading Job Parameters from an XML File .......................................................................................................................... 20
   3.4.3. FlexRip/Proof Job Parameters ........................................................................................................................................... 21
   3.5. Bar Codes tab ............................................................................................................................................................................. 23
   3.6. Step&Repeat tab ......................................................................................................................................................................... 26
   3.7. Categorization tab ..................................................................................................................................................................... 26
   3.8. Advanced tab ............................................................................................................................................................................. 27
   3.9. Automation tab .......................................................................................................................................................................... 28
   3.10. Page Assignment tab ............................................................................................................................................................ 28
   3.11. Imposition tab .......................................................................................................................................................................... 29

4. **About Job Folder Location** ............................................................................................................................................................ 30
   4.1. General Note on Data Structure ............................................................................................................................................. 30
   4.2. FAQs on Job Folder Location .................................................................................................................................................. 31
   4.3. Good Practices regarding Job Folder Location ...................................................................................................................... 32

5. **Uploading Files to Jobs** ................................................................................................................................................................. 34

6. **Milestones: Tracking Job Status** .................................................................................................................................................... 35
   6.1. Concept ...................................................................................................................................................................................... 35
   6.2. The Milestones View .............................................................................................................................................................. 36
   6.2.1. In Job Overview Mode ......................................................................................................................................................... 36
   6.2.2. In Job Mode ........................................................................................................................................................................ 38
   6.3. Adding Milestones to a Job ....................................................................................................................................................... 39
   6.4. Manage (Custom) Milestones ................................................................................................................................................ 41
6.5. Working with Milestone Actions................................................................. 42
6.6. Using Milestone Statuses to Filter Jobs.................................................... 44
6.7. Using Milestones in Workflows: the Manage Milestone Task.................. 45
6.8. Informing Other Systems of the Milestones Statuses................................ 47

7. About Removing Jobs................................................................................... 48

8. Tasks you can Launch on Jobs...................................................................... 51
   8.1. The Relocate Job Task............................................................................ 51
   8.2. The Archive Job Task............................................................................ 52
   8.3. The Restore Job Task............................................................................ 54
   8.4. The Check Job Parameters Task............................................................. 56
   8.5. The Remove Job Task............................................................................ 57

9. Automated Creation of Jobs.......................................................................... 59
1. Job Basics

1.1. The Job Concept

What is an Automation Engine Job?

An Automation Engine Job represents an amount of work to be done for a certain order in your business system. This can be a classic order management system but it could also come from a web application that needs Automation Engine to execute some prepress tasks.

A Job is an entry in the Automation Engine Jobs database and has a unique name. In the Pilot, Jobs are represented by this blue folder icon.

In Automation Engine, a Job consists of 2 things:

• **data**: files and folders, stored under the Job's **Job Folder**, in a Container.
• **metadata**: the parameters of that job order, usually how the order management system describes this job. They can be general parameters like the job's name, order ID, customer and due date but can also be parameters describing what to do with the input files to get to the targeted result.

Jobs can be created manually by an Automation Engine user or automatically via some integration with an external system.

A Job represents Work In Progress (WIP). This means that you should remove jobs that are 'done'. Removing a Job from the Automation Engine Jobs database does not mean that you have to delete the related data files.

**Most Automation is based on Jobs**

A lot of the automation that Automation Engine brings comes from the fact that tasks can automatically use parameters from their job context. Job parameters automatically become SmartNames and the (workflow) task tickets can use those SmartNames to pick up their values.

**Note:** Customers that do not use jobs at all find a similar level of automation by using **Workflow Parameters**. Learn more in *Using Workflow Parameters*.

**Launching tasks on Jobs**

Jobs can be managed manually in the Pilot, but several actions are also possible by launching tasks.

• The **Create Job task** task allows to create and modify Jobs.
• The **Check Job Parameters** task allows to check and correct barcode and ink parameters used in designs.
• The **Archive Job** task and the **Restore Job** task allow to remove jobs, store their data on a different network place and, if needed later, restore them back, including their metadata.
1.2. Types of Jobs

Conceptually, we can distinguish several types of Automation Engine Jobs. This categorisation usually depends on these factors:

• What type of site are you? Does your company only do prepress or do you also produce? And if you produce, do you also re-produce items that you produced before?
• Is your Automation Engine closely integrated with your order management system? If it is, then Automation Engine best follows a similar process logic as in that system. Terms like jobs, orders, products, items, milestones etc. will need to have the same meaning.

We distinguish 3 types of jobs:

Attention: The categorization of these job types does not appear in the user interface of Automation Engine. Their names are only used here to illustrate different ways of working with the tools Jobs and Products. Learn more about Products in Products.

Type 1: A Prepress Job

The goal of a Prepress Job is to make a single one-up design print-ready. Typical steps are preflight, making print-ready and approval. The result is a file that is ready to be produced.

Some variations:

• The production can then be done in-house (in another Job, under another order number) or the print-ready file can be sent out to a company that produces.
• The resulting file can be registered as an Automation Engine Product.
• A Prepress Job can result in multiple files, but only when they belong to the same product item, for example front and back graphics. They probably also share the same approval cycle.
• At (flexo) prepress houses ('trade-shops'), the result could also be a set of plates.

The Job can be removed when the work is done.

Type 2: A Production Job

A Production Job is a job that uses one or multiple product items for a specific production run. The product items were already approved and print-ready. The goal of this type of job is output.

A Production Job does not contain the one-up's data in its job folder, but links to one or multiple Products. The job folder of a Production Job typically only stores the layout files or other data that are unique to this specific production order. The product data stay in their Product Data Zone.
The Job can be removed when the work is done. The Products are not removed, they stay 'live' until a next Job links them in for another production run.

**Type 3: An All-In-One Job**

Some customers have Jobs in which they handle both the prepress work and the output production. The one-up data is stored inside the job folder, not registered as a Product and the workflow continues within this job with the productions steps (layout, plates, send to press...). Production related data is also kept inside this job folder.

In some cases, when the output is combined with other (already existing) items, this can mean that the one-up data is copied from other (older) jobs into this job folder.

The Job can be removed when the complete work is done.

![Attention: In this chapter, we will describe the use of Jobs without the use of the Products tool.](image)

### 1.3. The Job Views

#### 1.3.1. General Job Views

The Pilot and its Views were introduced in *The Pilot’s Main Window*. We here illustrate some job-related specifics:
1. Type of View.
   * The Containers view shows the folder structure of your Containers but will show a folder in blue when it is an active Job Folder. Double click any blue folder to select and view that job.
   * The Job Overview shows all jobs (or a filtered list). You can combine this with Smart Views.
   * The Last used Job view opens the last used job in the job specific view.

2. Info. This button opens the Job Setup of the selected job. Learn more in Job Setup Parameters on page 15.

3. Search input field. Learn more in Job View Filters on page 8.

4. Job Overview. Define the columns and their order in View > Select Columns in 'Jobs'....

5. Job Details. See some of the job's details. Learn more in Job Setup Parameters on page 15.

6. Amount of Jobs (selected).
Note: When you open the drop-down list, you can select another job that you recently used. You can set the amount of remembered jobs in Edit > Preferences > Pilot.

Tip: If you regularly switch between same views, consider using multiple view tabs (File > New Tab). For example:

1.3.2. Job View Filters

Basic Searching

When you type in a filter in the Search input field, the filter will be looked for in All of the default attributes: Order ID, Name, Project ID, Customer Job Reference.
Tip: You can use double quotes to restrict the search. For example

- `FL 123` will list jobs that have both `FL` and `123` in at least one attribute.
- "FL 123" will only list jobs that have this exact string in at least one attribute.

Click **Save** to save this search. Decide if it is for all users or only yourself and if you want to add it to your views bar.

![Save dialog box](image)

**Advanced Searching**

If you want to search in other attributes, or if you want to create advanced search criteria, click on the + button. A new search criterion appears.

See how the attributes drop-down list offers many more attributes:

![Attributes drop-down list](image)

In the drop-down list, select **Other...** to add even more attributes to this list. For example **Customer name**.

Use the + button to continue adding search criteria. For example:
You can even add 'logical operators' to your criterion. Hold \texttt{Alt} when clicking on the \texttt{+} to start your criterion with \texttt{All}, \texttt{Any} or \texttt{None}. See this example where you are not sure which CSR handles this job order:

Click \texttt{Hide Criteria} to hide the lines with the criteria but still have them active.

As shown above, you can save the (set of) search criteria. You can re-use it later as a Smart View or pick it from the drop-down list in the search field:

\textbf{1.3.3. Job Specific View}

When you select a job from the drop-down list of last used jobs, or when you double click a blue job folder, the view adapts and focuses on that job.

\begin{itemize}
  \item The Pilot top bar mentions the name of the selected job.
  \item The \texttt{Last Used Job} drop-down list mentions the name of the job folder.
\end{itemize}
• The Folders pane shows the (blue) job folder, its subfolders and their files.
• The Tasks pane shows the tasks that were launched in this job context.
• The list of favorite tickets also shows (blue) job tickets (saved for this job only).

All tasks that are launched in this view will run "in this job". Job-based SmartNames will now get their values from this job.

1.4. The Job Menu

**Note:** When no job is selected, some of the menu options are unavailable.

• **New Job**.... Learn more in *Creating a Job* on page 13.

• **Go to Job.** When a job is selected in a list, use this to go to that job ('open' the job).

• **Job Setup**.... This opens the Job Setup dialog of the selected job.

• **Find Job**.... This opens a separate dialog to search for jobs. Learn more in *Job View Filters* on page 8.

• **Relocate Job**. This moves the job folder of a (live) job. Select the ticket of the Relocate Job task. Learn more in *Tasks you can Launch on Jobs* on page 51.

• **Remove Job**.... This removes the open or selected job(s) from the jobs database. You will be asked to confirm and you can choose to keep the files and folders. Learn more about removing multiple jobs and re-creating them in *About Removing Jobs* on page 48.

• **Delete View Data**.... This deletes all View Data present in the job folder. View data are stored in hidden subfolders of files that were prepared for viewing in the Automation Engine.
Viewer. You will be asked to confirm. You can choose to Also unmark subfolders that are marked for Speed for Viewing. Learn more about this feature and View Data in Prepare for Viewer Task.

- Manage Job Filters.... This opens a dedicated dialog to manage job filters. Learn more in Job View Filters on page 8.
2. Creating a Job

You can create jobs manually or they can be created automatically.

Creating a Job Manually

To create a job, you can first select an existing folder that will become the job folder, or you can have a new job folder created while you create the job. Follow these steps:

1. In the Pilot, choose one of these methods to create a new job:
   • go to Job > New Job...
   • right-click (on an existing folder) and select New Job...
   • click the Create Job icon
   • (select a folder and) use Ctrl + Alt + N (Windows) or Cmd + Alt + N (Mac).

2. In the New Job dialog, decide if you want to use an existing job as a template.
   • If you don't use a template, click OK and fill in all the parameters in the next dialog.
   • If you want to an existing job as a template, select it and decide which type of parameters you want to include from that job in your new job. Then click OK.

   ![New Job dialog](image)

   The job you use as a template could be a job that is similar to the new one (for example the 123-lemon job has many same attributes as the 234-banana job). It could also be a job that you specifically created to be used as a template (the typical 'flexibles' job for example).

   The status, actions and confirmation dates of the milestones in the template job will not be added to the new job. Their due dates will be relative to the creation date of the new job. For example: you want the new job to also get the milestone 'proof ready' 2 days after it was created.

3. A dialog opens with the Job setup. Now you can fill in all the parameters for the job.

   If you started from an existing folder or used a template, several parameters will already be filled in.
Creating Jobs Automatically

In most cases, the Automation Engine Job originates in another system. Recreating that job manually in the Pilot is not an efficient way of working. It is strongly advised to integrate Automation Engine with that other system and so have the jobs come in automatically. This will both win you time and reduce errors.

This integration can be based on an incoming file that describes the job or could be a bi-directional link with that external system. In both cases, the Create Job task will create the Job in background (probably as part of a workflow task). Such an automated workflow can also update Jobs with new or changed parameters.

Learn more in Integrating with External Systems.
3. Job Setup Parameters

You can fill in the job setup parameters while creating a job, or, when you are in a job context, by going to Job > Job Setup....

In an existing job, you can add or modify parameters at any time, except the Order ID and SubOrder ID. Learn more in Job tab on page 15.

The parameters are spread over multiple tab sheets. The tab sheets Automation, Page Assignment and Imposition only appear when you are using the module for page workflows.

Most job parameters are automatically offered as Job SmartNames. Learn more in SmartNames.

The button Apply Job Setup... allows to copy parameters from other jobs. Select the job and define which type of parameters you want to include from that job.

![Apply Setup dialog](image)

This is similar to how you can use a template job at the moment of job creation. Learn more in Creating a Job on page 13.

3.1. Job tab

The Job tab contains the main job order information:
Thumbnail: When there is no thumbnail yet, it will automatically be set when one of these tasks finishes with success: “Normalize PDF”, Normalize PostScript / PDF / Illustrator 8.0 File” or “Export ArtPro to PDF”. To set the thumbnail manually, right-click the field and select a file (that has a thumbnail embedded).

Order ID: order management systems typically define a job order by an identification number. This is a mandatory field.

Caution: You can not change it once the job is created.

SubOrder ID: often, a job order also has a sub number (or text). You can leave this field blank.

Caution: You can not change it once the job is created.

Important: An Automation Engine job needs to be unique. More specifically, the combination of Order ID and Suborder ID needs to be unique.

Job Name: this is the name that you see in the job overview lists. This is a mandatory field. If you do not enter a name here, the name will be "OrderID_SubOrderID".

Important: Also the name of the job needs to be unique.

Note: You can change the name after the job was created.

Note: The job name will also be proposed as name for the job folder. Learn more below.
Description: a short text describing the job order. By using its SmartName version, this text can for example also be picked up in a report PDF.

Due Date: the due date and time for this job order. This date is used in job filtering and also in several tasks that allow choosing the Job Due Date as one of the choices for the task due date. For example the Submit to Gang Run task and the Publish on WebCenter task.

Project ID: the identification number of the project that this job order belongs to. Project numbers are typically defined by the order management system or any other external system. This parameter can be useful to find jobs that belong to a same project. This parameter can match to a project on WebCenter.

Category: choose a category from the list. Categories are often used to help you find jobs or to define the route of a workflow. Click the button Categories... to add new categories manually or by loading a list from an XML file.

You can add more custom categories. Two are offered in this tab sheet: Custom Field 1 and Custom Field 2. You can set four more in the tab Categorization. You can configure their custom names in Configure - Jobs - Job Setup. See an example in the above screen shot.

Tip: In the page about the tab Categorization, you can find a table with matching names of categories, custom fields and their SmartName versions.

Last Actor: the last Automation Engine user that worked with this Job (launched a task, opened a file). This is filled in automatically but you can set it manually too.

Job Folder: define the path of the job folder for this job. You can choose one of these methods:

• browse to an existing folder (somewhere in one of your containers).
• browse to the root of where you want to create the new job folder and click . By default, the job Name will proposed as name for the job folder. You can change that if you want to.
• Use the Smart Job Location defined in the Configure Tool: when this toggle is selected, the location and name of the job folder will be calculated based on a job parameter or on the default location for that customer. A preview of the folder’s location and name can be asked by clicking the Show Job Location button. Learn more in Smart Job Location.

Tip: The browse button can also be used to relocate an existing job folder. When you here change the path of an existing job folder, you will be asked if you want to move or copy the data to the new job folder.

3.2. Customer tab

Customer ID: click Select... to open the Select Customers dialog. Choose one or add a new customer. Learn more about creating customers in Customers.

Customer Name and Customer Description: these fields will be filled out automatically after selecting a customer.

Customer’s Job Reference: this is how your customer refers to that job, how they named it (initially). When communicating with your customer, he will appreciate if you mention this name (as well). You can for example add this name as a SmartName to a report PDF or add it to a name of a file that you send him.

Customer Service Representative (CSR): select or type the name of the person in your sales or service department who manages this customer account.
The **E-mail** address of the CSR that you selected is automatically displayed if it was used before. You can also enter the E-mail address manually.

You can click the **Contact...** button to open an E-mail message with that E-mail address in the **To** field (if an E-mail client is configured).

**Tip:** All these parameters
- can be used to filter or search for a job.
- can be entered via XML/JDF/JMF. It is strongly advised not to re-enter these admin data manually. Learn more on how this can be done in *Integrating with External Systems*.
- exist as **System SmartNames**.

### 3.3. Inks tab

This tab sheet allows to store ink specifications for this job.

What you enter here serves as a *minimal* requirement for this job. This means that you can for example only enter the angles for a specific set of ink names and leave all other fields or columns blank.

As with most tab sheets, you can enter this data manually, copy these parameters from another job (see the button **Apply Job Setup...** or get them from an XML when using the **Create Job task**.

**Use cases**

Job ink parameters can be used in these cases:
- When you import design files, the task **Normalize PostScript / PDF / Illustrator 8.0 File** offers to enforce these job ink parameters in the output file.
• In PackEdge or ArtPro, when you open a file that is located in a job folder, the editor will check if the file's inks match the job ink parameters and show a warning when they don't. You can also use the Load Job Parameters feature in the editor's Inks dialog to enforce the job ink parameters.

• When you use the Check Job Parameter task, you can check and or modify the attributes of the inks in the file.

• In page workflows, when you use the Variant Setup in the Imposition tab, the job's inks will be used.

**Note:** A job can only have one set of ink parameters.

**Preferred Ink Book:** When you then type an ink name in the table, Automation Engine searches for the ink in your preferred ink book first. For example, if you type 154 as ink name, and your preferred ink book is Pantone Colors Uncoated, Automation Engine will automatically suggest the ink PANTONE 154 Uncoated.

**Printing Method:** You can set a printing method per ink. The list shows those defined in the Configure tool.

These are typical examples of how to make use of a Printing Method:

• In your Imaging Engine (RIP) task for a flexo device, you select only the inks of printing method 'flexo'.

• You make a special ReportMaker PDF that focusses on the 'ink' used for embossing. In your workflow, you use the Extract Inks task to select the wanted ink type before you start the ReportMaker task.

**Some tips on editing the ink list**

• To start, click in the empty canvas under the column Ink Name and type in an ink name. For example 'C'.

• You can define specify ruling, angle and dot shape per ink name or use the buttons at the bottom of the tab sheet to specify them for all inks.

• **Ruling** uses the unit as defined in Edit > Preferences... > Units.

• To change all fields in a column with a same value, double click the column header (valid for Ruling, Angle or Dot Shape).

### 3.4. Parameters tab

This tab allows to store two types of job parameters:

• custom job parameters, with a name and value that you decide. They will also appear as a SmartName.

• FlexRip/Proof job parameters. This is an older technology that allows enforcing job parameters into the FlexRip or FlexProof task tickets. Learn more in FlexRip/Proof Job Parameters on page 21.

**Note:** With Imaging Engine, this concept is replaced by the use of SmartNames.

These job parameters can be created
• manually. Learn more in Creating and Modifying a Custom Job Parameter on page 20.
• by loading values from an XML file. Learn more in Loading Job Parameters from an XML File on page 20.
• by using the Create Job task, where you use the (XML) input from an external system. Learn more in Create Job task.

3.4.1. Creating and Modifying a Custom Job Parameter

Use the buttons Add..., Modify... and Remove to manage your custom parameters manually.

Follow these steps to add a custom job parameter:
1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope 'General'. Learn more about the other Scopes in FlexRip/Proof Job Parameters on page 21.
3. Type in the Name and Value and click OK.

The SmartName version will be created automatically. To easily recognize which SmartNames are job specific, their name starts with [jp. ].

3.4.2. Loading Job Parameters from an XML File

If you have an XML file that contains the custom job parameters, you can create them automatically by loading them into your job setup:
1. In the job setup tab Parameters, click Load....
2. In the Load Job Parameters from XML dialog, click Browse and browse to your XML file.
3. Click OK. You now have a custom parameter for all value pairs the XML contains from the root node.

An example result after loading the XML file:

Tip: If you have long parameter lists, you can use the search field to help you filter them. The value is checked in Scope, Name and Value.
For this example, see the automatically created SmartNames of these custom job parameters (for this job '1236'):

Learn more about using SmartNames in *SmartNames*.

### 3.4.3. FlexRip/Proof Job Parameters

**Creating Job Parameters for FlexRip or FlexProof**

1. Click **Add...** to open the **Add Job Parameter** dialog.
2. Choose the **Scope** of a specific type of FlexRip or FlexProof.
3. Check the parameters that you want to enforce during RIP'ing and define their value. For example:
Click **OK**. The job parameters for this type of FlexRip/Proof will be added as one line.

**Using Job Parameters for FlexRip or FlexProof**

When you now select a file in that job and open a task ticket for that particular FlexRip/Proof, you will see fields that are marked by an orange icon. These are fields that are overruled by the job parameters.

For example:
Note: With Imaging Engine, this concept is replaced by the use of SmartNames.

3.5. Bar Codes tab

In the Bar Codes tab you can create parameters for multiple bar codes of different types.

Tip: One file can have for example a retail bar code and also a general purpose bar code that will be used for a filling station.

As with most tab sheets, you can enter this data manually or get them from an XML file when using the Create Job task.

Tip: When selecting a bar code, the specified parameters are shown in the Details area.

Similar to the Inks tab on page 18, these parameters can be used to enforce their parameters into the bar codes of the job files that you opened in PackEdge or ArtPro. Also here, the Check Job Parameter task can be used to check or correct the bar codes in the files versus the parameters you specify here.

See this example where the job parameters are enforced into the bar code in PackEdge:
We now briefly describe the available parameters. We refer to the documentation of your editor for more details.

**Type**

Selecting a Type is a mandatory choice.

*Note:* When you define more than one bar code, the checking mechanism with the editors and the Check Job Parameter task will recognize the type of bar code and check accordingly.

**Sub Type**

Some bar code types offer sub types. For example a **Datamatrix** code.

**Code**

The validity of the code is not checked here. This is done in the editors.

**Composite Code**

A **Composite Code** is a 2D symbol placed on top of a GS1 barcode, that encodes extra information (batch number, expiration date...).

**Output Resolution**

Enter the resolution (in ppi) that you will use to RIP your bar code. This parameter helps preventing unwanted levels of rounding in the bar width.)
Bar Width Reduction (BWR)

Use this parameter to adjust the width of the bar code bars, in order to compensate for ink bleeding when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells you that the line width will increase by 0.01 mm, you should use a Bar Width Reduction value of 0.01 mm.

Important: This field expects a value in millimeters (mm).

Important: If you use a comma as a decimal symbol, it will be replaced by a dot.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar’s width to compensate for bleed caused by the plate or film making process.

Important: This field expects a value in millimeters (mm).

Note: If you use both a Bar Width Reduction and a Device Compensation value, the software will add them together to adjust the bar’s width.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Narrow Bar

This parameter determines the width of the narrowest bar of your bar code (and affects the width of your bar code proportionally). For GS1 bar codes, this affects the size (height and width) of your bar code proportionally.

Magnification

Use this parameter to increase or decrease the bar code size proportionally. For example: enter 1.25 for a magnification of 125%.

Important: The value needs to be between 80% and 200%.

Ratio

The Ratio is the factor between the width of the narrowest bar and the width of the widest bar in your barcode. For example, enter 3 if you want your widest bar to be three times as wide as your narrowest bar.
3.6. Step&Repeat tab

Specific JDF

This tab with Step and Repeat parameters is only useful in a workflow where you receive a JDF from an external system that describes the Step and Repeat via “JDF for Stripping for Packaging”. Such a JDF will not only create the job but also store those specific Step and Repeat parameters in this tab.

These parameters also become job parameter SmartNames and can so be picked up by Step and Repeat tasks. They will appear as [jp.steprepeat.].

**Note:** The task Import JDF Step & Repeat uses the JDF itself as input. In that case the values shown here are just informational and the task does not use SmartNames.

**Also via XML?**

Step & Repeat specifications can also come from external systems via an XML file or database queries or HTTP calls. In such cases, these parameters do not end up in this tab sheet and they also become other types of SmartNames. Learn more about this in Integrating with External Systems.

**Manual entry**

You can also enter values manually here but that usage is not different than when you would add them in the custom Parameters tab sheet.

3.7. Categorization tab

**Attention:** This tab only appears if you created custom categories in the Configure tool (see further).

The Categorization tab allows you to manage up to four extra custom Job Categories (you already have three category fields in the Job tab).

You can use these custom categories as extra ways to search jobs. And you can also use their SmartNames in task tickets.

**Creating and modifying a Custom Category**

Go to Tools > Configure > Jobs > Job Setup and type the name of custom category.

**Managing their Values**

To manage the list of values you can choose for each category, click the corresponding Manage... button, and add or remove items to the list. In this dialog, you can also load lists of items from an XML file by clicking Load...
Overview of Custom Categories and their SmartNames

Because there is already 1 *standard Job Category*, the number of your custom categories will be 1 higher. See this overview:

<table>
<thead>
<tr>
<th>name of Job setup tab</th>
<th>name of category in Job setup</th>
<th>custom field number</th>
<th>name of SmartName</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job</td>
<td>&quot;Category&quot;</td>
<td>/</td>
<td>Job Category</td>
</tr>
<tr>
<td>Job</td>
<td>name you gave</td>
<td>custom field 1</td>
<td>Job Category 2</td>
</tr>
<tr>
<td>Job</td>
<td>name you gave</td>
<td>custom field 2</td>
<td>Job Category 3</td>
</tr>
<tr>
<td>Categorization</td>
<td>name you gave</td>
<td>custom field 3</td>
<td>Job Category 4</td>
</tr>
<tr>
<td>Categorization</td>
<td>name you gave</td>
<td>custom field 4</td>
<td>Job Category 5</td>
</tr>
<tr>
<td>Categorization</td>
<td>name you gave</td>
<td>custom field 5</td>
<td>Job Category 6</td>
</tr>
<tr>
<td>Categorization</td>
<td>name you gave</td>
<td>custom field 6</td>
<td>Job Category 7</td>
</tr>
</tbody>
</table>

3.8. Advanced tab

This tab sheet offers a feature to automatically start a task or workflow when you create or update a job that uses this job as a template.

⚠️ **Caution:** This is an old feature. Please check below for the alternative ways to reach the same goal.

If you wish to use this, check the toggle and select the **Task Type** and **Ticket Name**.

**When is a job updated?**

A job is updated in these cases:

- when the JDF that created the job is sent again to Automation Engine. Learn more about JDF in [*Integrating with External Systems*](#).

- when a **Create Job** task is launched again on the same job.

**When is this feature useful?**

This feature can be useful when you have jobs that are created automatically via JDF without the automatic launching of tasks at that moment. Your JDF can then specify that a job needs to be used as a template. And that template job can have this parameter active to launch a task.

**Alternative methods**

There are other ways to launch a workflow in a job that was just created or updated.

The **Create Job task** can
3.9. Automation tab

**Note:** This tab is only offered in page workflows.

The Automation tab offers tools to automate your page workflow. When a certain job related event happens, a specific task can be launched automatically, which then can lead to a next status in the workflow.

You can do this for **Normalization**, **Proofing** and **Exposing**.

![Automation tab interface](image)

- Choose how you want to normalize the file **when a page is delivered**. Select a single task or a workflow.
- Choose when you want to launch a **proofing** output task: **when a sheet side**, **a variant** or **an imposition** is complete. Select a task.
- Choose when to **expose** your job: **when a plate**, **a separation set** or **an imposition** is ready (complete and approved if required). Select a single task or a workflow.

3.10. Page Assignment tab

**Note:** This tab is only offered in page workflows.

This tab offers settings to automate the assigning of incoming PDF files to Page slots. Learn more in *Page Assignment via Naming Convention*.

Learn more about the Pages tool in *Working with Pages*.
3.11. Imposition tab

**Note:** This tab is only offered in page workflows.

- **Variant Setup**
  When working with variants, this allows you to select the correct use case and variant separation from the list. Learn more in *Variant Setup*, a section of *Working with Plates*.

- **Output prerequisites**
  These settings allow you to decide when a separation can be considered as being ready.
  - **When no page is rejected:** This is called "implicit approval". The plate status in the *Plates View* will indicate 'ready for ripping' if all the pages of the plate are assigned and if no page is rejected. When a page for that plate is unassigned or rejected, the output task on a plate will fail.
  
  - **When all pages are approved:** This is called "explicit approval", it is more strict than "implicit approval". The plate status in the *Plates View* will only indicate 'ready for ripping' if all the pages of the plate are approved. When not all the pages on that plate are approved, the output task on a plate will fail.

  Learn more in *Task status information*.

  Learn more about the Plates tool in *Working with Plates*. 
4. About Job Folder Location

4.1. General Note on Data Structure

Automation Engine allows you to choose your own data structure

As mentioned in "Containers (an Introduction)", Automation Engine will work with the data structure you have.

This freedom also brings requests for advice on what data structure could serve your specific needs the best. The more you learn about the available tools (Jobs, Products, SmartNames, Workflow Parameters etc.) the more you will learn what is (no longer) important in that data structure.

Historical View on Data Structure

Before there were workflow automation servers like Automation Engine, prepress managers built up their own logic in the prepress data structure. Prepress operators browsed many folders in the network to open a file in their workstation editor and then saved it again, often with a changed name.

Very typical was the habit to write information about the files into both their name and their location. For example: a final version was named "name_final.pdf" or written in a folder "Final". Or a file was named "lemon_c_m_y_k_pms123.pdf". Or when the job was ready to be archived they moved the whole job folder to a share "For Archive".

Then came workflow servers like Automation Engine where the information is (automatically) stored in database fields. And the user can see information via a dedicated interface: the Pilot. You can for example list all jobs of the category "NON-FOOD" or you can use the "i" button to see the PDF's inks (XMP metadata).

Does this mean that the data structure and the file naming is less important than before? No, actually the opposite is true.

Why is it still Advised to have a Logical Data Structure?

There are two main reasons why a logical data structure is more important than ever:

• for the people that do not use the Pilot.

Are there non-prepress users looking directly at your prepress data structure? If those people are not using the Pilot interface, they will still want to get information from the location or from the name (like in the 'old days').

Note: We advise to check if those colleagues will not prefer to install a local Pilot and benefit from that information-rich view. Remember you can use User Access Rights to limit their access. And they could even benefit from using the Viewer.
• **for external systems** that look at, use or deliver the data.

What other systems are looking at your data structure or at files that come from there? What systems send you data into that data structure?

The integration of Automation Engine with many other systems is the main reason that your data more than ever needs to be well structured and named. Learn more in *Integrating with External Systems*.

For these reasons we advise to:

• investigate thoroughly what data structure will serve your needs and those of the system(s) you (will) integrate with. This includes avoiding copied data.

• use all the tools that can automate the creation of those folders and file names (templates, SmartNames, Smart Job Location etc.).

### 4.2. FAQs on Job Folder Location

#### Can I Move a Job Folder?

As explained in *The Job Concept* on page 4, a job is a temporary object. But even during its short life time, it can happen that you want to move the physical data to another place in the network.

In this case, it is very important that you use one of the tools in Automation Engine to do this. If you use the OS tools (Windows Explorer, Mac Finder etc.), Automation Engine will not be aware of this move and its database field for the job folder will still refer to the old path.

You can relocate a job folder

• manually, one by one. By using the browse button in the job setup. You will have the choice to move or copy the folder.

• by using the **Relocate Job** task. You can launch this task on multiple jobs (for example on a smart filtered selection).

#### Can I Rename a Job Folder?

To rename a job folder you can use the same manual relocation tool as mentioned above.

1. In the **Job** tab of the job setup, in the field with the job folder path, change the name of the folder.

2. Click **OK**. The resulting dialog offers a choice on what to do with the original folder and files.
3. Make your choice and click OK.

**What happens when I Remove a Job Folder from a live Job?**

When Automation Engine can not access the job folder of a job that you are trying to open or use, a warning dialog will mention *"Could not retrieve the list of files"*. The Pilot will show the job folder in yellow.

This is the same warning that you will get when there is network problem and Automation Engine can for example not access a complete **Container**.

When Automation Engine can again access that folder again, with the place and name it was expecting, the job folder will again be shown in blue and ready for use.

**Note:** In the Configure tool, there is a feature that allows to remove all "dangling jobs" (jobs that have no more link to their job folder). Learn more [here](#).

### 4.3. Good Practices regarding Job Folder Location

Creating all your job folders under 1 same root folder can result in a slow Automation Engine Pilot and even slow tasks. We advise not to do this.

Here is an example setup that certainly causes too many subfolders in one same folder:

To keep your system healthy, it is good practice to use subfolders in your data structure.

Here is some advise on what logic you could use to decide that data structure:

**About using Subfolders per Customer Name**

We do not advise this, mainly because customers tend to change their names. It looks like a good idea at first, but Esko has seen many customers migrating away from this structure.
About using Subfolders per Customer ID

We do not advise this. It is true that using a customer ID is more stable, but it also has some disadvantages:

- That customer ID number is often meaningless to the Esko users.
- Because legal regulations may require your company to keep track of order history, it is possible that old customers may not be deleted in the business system. That is why, when your customer changes his name, some business systems then change the ID anyway.
- Another reason to not base your folders on customer ID is that customer companies also merge.

These reasons show that we again face the same issues as when we use the customer's name.

About Using Subfolders per Type of Job Order

We do advise to base a data structure on types of jobs.

If you have prepress orders (creating and getting a one-up print ready) and production orders (outputting existing approved data), then structure them in separate folders or even different Containers.

Or you can use the product or production type: labels, carton, digital, flexo, offset etc. A typical way to set this up is by using the SmartName of a job (custom) Category.

About Using Subfolders per Order Range

We do advise to create a data structure where you split folders based on the job's Order ID.

For example: all jobs in the 1000 range in one folder, all jobs in the 2000 range in the next folder, etc. This is a straightforward structure that will not allow more than 1000 subfolders in one folder. Use String Extract SmartNames to set this up.

This is considered to be the best practice.

For example:

---

Note: All these principles also apply to folders where you store Products (Product Data Zone). Learn more in the dedicated chapter on Products.
5. Uploading Files to Jobs

There are many ways to upload files onto a job folder.

- **Manually:**
  - using the Pilot
    - drag and drop files or folders from outside the Pilot onto a job (sub)folder in the Pilot. Or use copy/paste shortcuts.
    - right-click a job (sub)folder and choose Upload Files.... Learn more [here](#).
  - right-click a job (sub)folder and choose Upload Files from FTP Site.... Learn more [here](#).
  - using Shuttle, as start of a workflow in this job. Learn more [here](#).

- **Automatically:**
  - from Access Points. Any of the 5 types of Access Points can upload data to a job (sub)folder (and launch a workflow). The Folder Access Point can also be a subfolder of the job folder. Learn more in [Integrating with External Systems](#).
  - using the Download WebCenter Document task. When your Automation Engine is connected to a WebCenter, this task logs on to WebCenter and downloads documents from a specified WebCenter project. Learn more in [Integrating with WebCenter](#).
  - from WebCenter,
    - by synchronizing the WebCenter project with an Automation Engine job. When a WebCenter project has a workflow connection with an Automation Engine job, documents can be copied to that job when synchronizing. Set this up in the Configure page of the WebCenter project.
    - by using WebCenter's Sync Workflow task in a WebCenter workflow. Learn more in the [WebCenter documentation](#).
6. Milestones: Tracking Job Status

6.1. Concept

Milestones represent important moments in the life of an Automation Engine job. Each job has at least one Milestone: the moment it was created. You can add Milestones, predefined ones or custom ones. Each Milestone has a due date and several other attributes (see below). The goal of a Milestone is that it gets confirmed.

**Note:** The **Job Due Date** that you set in the job setup is not automatically created as a Milestone.

A Milestone has these attributes:

- a **Name**. For example "Approved".
- a **Due Date**. This is the time that this Milestone is expected to be confirmed. It could represent when deliverables are expected (plates, print production, shipping, invoicing). Or it could stand for the time an action is expected to be finished, for example "Approved" in 3 days.
- a status. Users can decide on the status **Confirmed** or not (still "pending").
- a set of **Actions**. You can optionally attach Actions that need to be done to get that Milestone confirmed.
- a **Responsible** user.

Milestones can be created and managed

- manually, by a user in the Pilot.
- by copying them from a template job (manually or via the **Create Job task**).
- by the **Manage Milestone task**.
- by an external system, using JDF/JMF. Learn more in **Integrating with External Systems**.

**How can you Use Job Milestones?**

Milestones can be used

- as the basis for **status feedback to external systems**. This is the main reason to invest in setting up and using Milestones.

Automation Engine focuses on reporting what happens with a job but not on job organization or job distribution: that is the task of the order management system. What is important is that Automation Engine reports back to such systems and that this ideally happens without manual intervention of prepress users (who have other things to focus on). Learn more in **Informing Other Systems of the Milestones Statuses** on page 47.

- in the Pilot,
  - when **filtering** jobs. For example you want to remove all jobs that have a milestone "Finished" confirmed more than 2 weeks ago.
  - as **visual help when tracking the status of jobs**.
6.2. The Milestones View

This view is different when you are using it in the **Job Overview** mode or in the **Last Used Job** mode.

Both these views use these icons for different milestone statuses:

- ✳ indicates the time the job was created.

- ❒ indicates the current time on the timeline.

- ❖ indicates a pending milestone (not confirmed).

- ✯ indicates an overdue milestone: the current time is later than the due date of the (pending) milestone.

- 🔳 indicates a milestone that contains one or more **Actions** that are not all **completed**. Learn more in *Working with Milestone Actions* on page 42.

- ✢ indicates a pending milestone of which all **Actions** are **completed**.

- ✔ indicates a confirmed milestone. A milestone must be completed before it can be confirmed.

6.2.1. In Job Overview Mode

When you are in **Job Overview** mode, you can see all milestones of a (filtered) list of jobs. The **Milestones** view offers two types of overview.

**The Timeline View**

The **Timeline View** shows you the milestones for a defined period.
Use these buttons to define the time period you are viewing:

• 
  • 

• 
  • 

From the menu Milestones, use Go to Date... to specify a specific date in the center of your view.

Select a milestone to see Milestone Details in the bottom pane.

Tip: When hovering over a milestone icon, you will see its name and more details:

Tip: Double click a milestone icon to open the milestone view for that specific job.

The Status View

The Status View shows the milestones and their status in columns.
Go to View > Select Columns... to choose which milestones will be shown here and to define the order of these columns.

If no icon appears in a milestone column, this means that this milestone is not defined for that job.

6.2.2. In Job Mode

In Last Used Job mode, the Milestones view shows all the milestones for a specific job.
Select a milestone to see it selected in the time line and to see details below about any actions for this milestone.

Printing out the Job's Milestones

You can use **Milestones > Print Milestones** to print (or save to PDF) a view of a job's milestones. You can define the printer's page format but the content of the page is fixed. The page shows some major job info and the milestones' timeline and overview.

An example:

![Milestones Timeline](image)

**Note:** The thumbnail of the job shown in this printout is the one you can (manually) add in the **Job** tab sheet of the job setup.

6.3. Adding Milestones to a Job

Adding a Milestone Manually

1. Select your job and open the **Milestones** view.
2. Click ![New Milestone](image), or go to **File > New Milestone**.
3. From the Milestone Name list, select the milestone you want to add to this job. If the one you want is not yet in the list, click Manage... and create it there. Learn more in Manage (Custom) Milestones on page 41.

4. If you want, add a Description for your milestone.

5. Define a Due Date and time. This is a mandatory field.

6. If you want, add a Reminder. Choose an absolute time or a time relative to the due date. At that time, a reminder will be E-mailed to the Responsible user.

7. Select the user that is Responsible for this milestone. This is a mandatory field when you set a reminder.

8. Click OK.

Copying the Milestones from another Job

When you create a new job (manually or via the Create job task or via JDF), you can copy the properties of another job (template) to that new job. This can include the milestones of that other job.

The copied milestones will be set relative to the creation date and time of the new job.

For example, a typical job for your customer FruitCo has a job due date of 9 days after job creation and during that period it includes 3 custom milestones. The due date of the new job that copies those milestones will then be set to 9 days after its creation date. And its milestones will be created relative to the new creation date.
6.4. Manage (Custom) Milestones

There are many predefined milestones, but you can also create custom milestones.

In the Milestones view (in Last Used Job mode):

1. Go to Milestones > Manage Milestones. This dialog shows you all your milestones and their attributes:

   ![Manage Milestones dialog]

2. Click the Add button.

   ![Add dialog]

   In this dialog:
   - enter a Name for your custom milestone.
• you can also enter a **Nickname**, this is the name that will be shown in the Pilot interface. This is also useful when your milestones are managed by JDF/JMF. Learn more in *Integrating with External Systems*.

• if you want, choose a **Color** and / or browse to an **Icon** to help recognize this milestone. Icons can be based on JPEG/PNG/GIF files and will be automatically scaled to a fitting resolution.

• you can also enter **Comments**. For example to explain all users how this milestone should be used or if an external system is using this milestone information.

• if you use the **Products** tool, define if this milestone can also be used as Products status.

• click **OK**. Your custom milestone now appears in the list and is ready to be added to jobs.

**Note:** You can safely remove milestones that you already used in jobs. Those jobs will not loose their (local copy) of the milestone.

### 6.5. Working with Milestone Actions

**Concept**

A milestone represents a status that you want to reach. A milestone can also list what **Actions** need to be done to reach that state. A milestone can only be **confirmed** when all its actions were set to **completed**.

Some customers use these tools extensively and ask their users to base their daily work on the milestone actions appearing in their **To Do List**. These users then use custom filters when over-viewing (their) actions. They typically filter their actions based on user, state and urgency.

**Creating Milestone Actions**

To add an action to a milestone:

1. Select the milestone in the **Milestones** view.
2. Click **⌘ N** or go to **Milestones > New Action...** or right-click on the canvas in the bottom part of the Pilot.
3. In the **New Action** dialog, enter what needs to be done, who needs to do it and by when.
The user that needs to do the action can later change the State from Pending to In Progress, Completed or Aborted.

**Working with Milestone Actions**

Milestone actions appear

- in the Milestone view, when in job mode. See a screen shot here.
- in the To Do List, as Milestone Actions. The To Do list offers some more functionality on these actions:
  - Right-click to open, delete or create a new action.
  - Right-click or click 🔄 to Forward the action to another user.
  - Check 'I am currently handling this item' to change the state to In progress.

Open (double-click) the action to use these extra tools:
6.6. Using Milestone Statuses to Filter Jobs

The filters that you make in Job Overview mode can also be based on milestones.

See this example of a filter that was saved as a Smart View named "Still Need Plates Today". It only shows jobs with an unconfirmed milestone "Plates Ready" that has a due date today:

Learn more on creating such filters in Job View Filters on page 8.
6.7. Using Milestones in Workflows: the Manage Milestone Task

Concept

Using milestones in workflows enables these principles:

- Milestones can help control a workflow. A workflow can check the status of a milestone before continuing (in a specific direction). Use the workflow control Router to do this. See an example here. Learn more in Router.

  **Tip:** When you also work with the Products tool, then check if the dedicated Wait for Product Status task is a better alternative.

- The Manage Milestone task helps to automate working with milestones. This task serves to create and confirm milestones as a workflow step. This enables a lot of automation when working with milestones. And you can also use it to hold workflows. Learn more below.

See an example of a workflow that automatically confirms four milestones:

![Workflow Diagram]

The Manage Milestone Task

You can use this task to automatically decide one or multiple of these milestone attributes:

- **Set all pending actions of the following milestone in state "Completed":** select the milestone you want to set as “Completed”. Learn more about Milestone Actions in Working with Milestone Actions. This setting is mandatory.

- **Create the milestone if it does not exist:** if the above selected milestone you selected was not yet added to the job, check this option to add it (otherwise the task will fail). The milestone will be created with the status "Completed".
• **Automatically confirm the milestone:**
  - Check this option to set the above selected milestone as "Confirmed" and have the workflow continue with its next step(s) or with any task that was waiting for this milestone to be confirmed.
  - Do not check this option if you are still waiting for a confirmation. The task will then serve as a hold-point: it will pause the workflow until that milestone is confirmed.
  - In the **Workflow Editor**, this step then will jump up and down, as a signal that a user intervention is needed:

    ![Workflow Diagram](image)

    Right-click the file-icon and choose to **Open Milestone...** or to **Show in Tasks View**.

• In the **Tasks** view, you will see the phase **User intervention needed**.

    ![Tasks View](image)

    Click on the red text to open the milestone dialog where you can change any setting.

    ![Milestone Dialog](image)

    If you check **Confirm Milestone** (and click **OK**), the workflow will continue. If you cannot confirm this milestone yourself but for example need the help of someone else, then type in a description and change the responsible user.

• In the **Milestones** view, right-click to open the milestone or directly click in the column **Confirmed** to change it to **Yes**.

    ![Milestones View](image)
**Tip:** Some customers make the manual confirmation of a milestone easy by offering the users a favorite ticket that only (creates and) confirms a milestone. This is useful when that user is aware of a status that Automation Engine has no information on.

For example: A plate room operator checks plates that come out of the developer. He reads their job number on the plate and types it in as a job filter in his simplified Pilot. He then launches the appropriate favorite ticket: **Plates OK** or **Plates NOT OK**.

![Automation Engine Pilot](image)

This information can now automatically change a workflow and/or be sent out to the system that does the press planning. Learn more about such feedback in the next section.

### 6.8. Informing Other Systems of the Milestones Statuses

The milestone status of an Automation Engine job is often more important to external people than to users of the Pilot. Many parties want to be kept up to date about the latest status in prepress, both colleagues and customers.

External systems are not always interested in all prepress details. You can choose to only inform them on some specific milestones.

These are tools that help inform other systems and their users:

- Add a **notification** to your **Manage Milestone** task. This can be an E-mail notification or the same message can also be written in an XML file for an external system to read. Learn more about the type and content of such messages in *Task Notifications*.

- Or you can use one of many tools dedicated to help integrate Automation Engine with external systems. Typical methods are
  - write out XML files
  - write directly in the database of the external system
  - when the external system is capable of subscribing to JMF signals, you can set up the automatic sending of JMF signals when a milestone is confirmed.

For more information on these feedback tools, see the dedicated chapter *Integrating with External Systems*. 
7. About Removing Jobs

Concept

An Automation Engine job represents a Work In Progress. It is expected that you remove the job when the work is done.

Removing a job means that it is removed from the Automation Engine jobs database. You have the option to keep the job folder data.

When you remove a job,

- all finished tasks in that job will be deleted. If you wish to keep those tasks, use the Task Cleanup Rules to move them (earlier) to the Task History tool.
- if that job still has unfinished tasks, you will be asked before removing the job to confirm that they can be cancelled and deleted.
- all Actions for that job in the To Do List will be deleted.
- any setup of Hot Folders in that job folder will be removed.
- when you choose to not delete the job folder, all the job's setup parameters will be stored in a subfolder ‘config’ (this is the information that was inside the database).
- the job will disappear from the Pilot’s Job Overview.
- in the Containers view, the blue colored folder icon will turn back into a standard yellow folder icon. You will be able to restore it later.

Note: The Archive Job task allows to remove the job (from the database) and move the job folder to a different place in the network. Learn more in The Archive Job Task on page 52.

You also have tools to reactivate the job, to recreate it back into the jobs database. See below.

Manual and Automatic ways to Remove Jobs

You can remove jobs

- manually, using the Pilot. Learn more below.
- by use of a workflow. This is usually a combination of the Select Job workflow control followed by the Remove Job task. Use the links to learn more.
- fully automatic, by having an external system launch a workflow that removes jobs. Also JDF can remove jobs directly. Learn more in the chapter Integrating with External Systems.

Removing a Single Job

To remove a single job, select the job and press Delete. You can also right-click (or go to the menu Job) and choose Remove Job....

You will be asked to confirm. You can choose to also remove the job folder and its contents.
Caution: There is no way to **Undo** the removal of the files and folders.

### Removing Multiple Jobs

In the Job Overview mode, you can select multiple jobs and remove them in the same way as described above. You will also get the option to keep or remove (all) their job folder data.

**Note:** It is good practice to use a smart filter when you select multiple jobs to be deleted. For example: all jobs that have their milestone ‘finished’ confirmed more than a month ago.

**Note:** There is no “Remove Job” task, so you can not remove jobs as a workflow step.

In **Edit > Preferences**, you can decide to avoid getting (many) questions when you remove multiple jobs:

- questions about jobs being in use by other users. A job is ‘in use’ when a user has this job open in his Pilot.
- questions about jobs containing unfinished tasks.

Learn more in *Pilot Preferences on Multi Job Removal*.

### Recreating a Job that was Removed

When a job was removed but the job folder data is still available, you can recreate that job back into the jobs database.

There are two ways to recreate a job:

- Recreating a job manually. Follow these steps:
  1. In Containers view, select the yellow folder that used to be the job folder of a removed job.
2. Right-click (or go to the menu Job) and choose New Job.... When a previous job setup is detected in that job folder (in the subfolder 'config'), you will be able to recreate that job. Choose to Reuse the previous setup.

3. Click Recreate. The renewed job will be opened and will contain the previous job setup parameters, subfolders and local (blue) job tickets.

- Recreating one or multiple jobs with the Restore Job task.

Learn more in The Restore Job Task on page 54.
8. Tasks you can Launch on Jobs

These are the tasks that you can launch only on Automation Engine jobs:

- The **Relocate Job task** moves the job folder of a job to another place.
- The **Archive Job task** removes a job and exports all its data and metadata into a ZIP file.
- The **Restore Job task** re-creates a job from a ZIP file that was created by the **Archive Job** task.
- The **Check Job Parameters task** checks or correct the input file's barcode and inks according its job parameters.
- The **Remove Job task** is used to remove jobs as a step in a workflow. This task is then preceded by the **Select Job** workflow control.

Like all tasks, these tasks can also be triggered by an external system. Learn more in [Integrating with External Systems](#).

The **Create Job task** is documented in the chapter [Integrating with External Systems](#).

8.1. The Relocate Job Task

**Concept**

This task allows to change the location of an Automation Engine job. The job itself does not change, only the path of its job folder.

**Restriction:** You can not launch this task as part of a workflow.

**Task Options**

- Enter the **New Job Location**. Keep in mind to end the location with the name of the job folder.
- You can choose to:
• Copy the files to the new location.
• Move the files from the original job folder to the new one.
• Not copy or move the files. The relocated job will then have an empty job folder.

**Warning:** If you move a job folder without using a tool from Automation Engine, the job setup field for the job folder will not be updated and the Pilot will show warnings. Automation Engine will keep trying to retrieve your missing files and this can slow down your server.

### Relocating Multiple Jobs

In Job Overview mode, (filter and) select the jobs you want to relocate. Right-click and choose a **Relocate Job** ticket:

![Automation Engine Pilot](image)

### 8.2. The Archive Job Task

#### Concept

The **Archive Job** task removes a job from the jobs database and exports the data in a form that enables to restore the job later.

Typical for this task is that it exports the job metadata as well, these are the job setup parameters. This metadata makes it possible to restore the job (back) later.

**Note:** The job's metadata is exported in a subfolder named 'config'.

**Note:** When you launch the **Zip task** on a job, the task only ZIP's the data inside the job folder, not the job's metadata.

**Note:** When archiving (removing) a job, the tasks that were launched in that job will be deleted. If you want to keep these tasks, use the **Task History** tool. This tool allows setting up rules that automatically move those tasks to a separate database (before archiving the job).
Task Options

- **Output in:** define where you want to write this archive data. For example, some customers use a 3rd party backup/archive solution that scans specific network folders for new incoming data. This system then archives that data online or writes it on a backup medium.

- **File Name:** define the name of the file in which all data will be stored. When you do not choose to generate a ZIP file, this will be a folder with subfolders.

- **Generate ZIP file:** deselect this option if you want to move the job folder to the above location without ZIP'ing all data.

- **Generate XML:** select this option to generate an XML file that describes this job. Such an XML file can be useful for a 3rd party archive solution that, for example, uses it to build up its search database.

- **Apply XSL:** select this option if you want to format the XML file using an XSL style sheet from a 3rd party archive solution.

- **Keep Job and Job Folder (Export Job):** deselect this option if you want to delete the job folder once it is successfully archived.

Select this option if you still want to keep the job in the job database and also keep the job folder in its original location. Here are some examples when to choose this:

- To use this task as a job backup tool.
- To exchange that job with another Automation Engine. For example, to send a job to another plant of your company (that also has Automation Engine) or to share the job with Esko Customer Service.

### Archiving Multiple Jobs

In **Job Overview** mode, right-click the selected jobs and choose your **Archive Job** ticket.

Here is an example of a smart way to archive multiple jobs. The filter lists all jobs that have their milestone "Job Finished" confirmed this week:
Using the Archive Job Task in a Workflow

You can end a workflow by archiving the job that the workflow was launched in.

Here is an example:

Notice these steps:

• After the plate making stage, the workflow waits for 2 weeks.
• It then sets the milestone "Ready for Archive" but without the option to confirm it. This triggers a request for a user intervention (learn more about this option the Manage Milestone task).
• When a user confirms this milestone, the workflow continues and archives the job.

8.3. The Restore Job Task

Concept

This task allows to restore jobs back to the Automation Engine job database that were previously archived using the Archive Job task.

Note: When the Restore Job task is a step in a workflow, it will only have the error output pin.

Possible Input Types
The input file for this task can be

- a ZIP file created by the **Archive Job** task.
- a job folder created by the **Archive Job** task.

**Important:** The ZIP file or the folder need to be created by a version of Automation Engine that is equal or lower than yours.

- an XML file that refers to the location of a ZIP or folder created by the **Archive Job** task.

The root node of the XML needs to have an XML attribute named "Location". The value of this attribute is the URL to the ZIP or archived job folder. Here is an example XML (it looks like the XML generated by the Archive Task):

```xml
<?xml version="1.0" encoding="UTF-8"?>
<Archive Location="file://aeserver01/Food/Archived Job Data/1237.zip"/>
```

**Task Options**

- **Output in:** Define where you want to place the restored job folder. Use [Job URL] when you want to restore the job to its original location and with its original job folder name.

**Note:** When you restore to a server that has a different name (typically a new AE server), then avoid using SmartNames that result in a value that contains that name of the old server. For example, [Job URL] will try to restore to a path containing the name of the old server. Consider defining an output path that also uses [Server], the SmartName for the name of the current server.

- **Job Name:** Define the name of job once it is restored. Use [Job Name] when you want the job's original name.

- **Order ID** and **SubOrder ID:** Similar to the job name, define a new ID or use SmartNames to use the ID's of the original job.
8.4. The Check Job Parameters Task

This task serves to check if your file matches specific parameters as defined in your job setup. You can also use it to automatically correct the file according to those parameters.

**Note:** For the task to function properly, the file should be part of an Automation Engine Job.

For **Barcode** settings, you can select:

- **Auto Correct** when you want to correct the file with what is specified in the job's **Bar Codes tab** on page 23.
  
  For example, your Normalized PDF includes an Esko barcode of type EAN-13 and code 123456789012, and your job parameters specify an EAN-13 with code 5449000050205, then this task will automatically correct the barcode number in the PDF to 5449000050205.

- **Stop with Error** when you want the task to stop with an error if the barcode in the job's **Bar Codes tab** on page 23 does not match the barcode in the file.

**Note:** This task only checks barcodes created in Esko PackEdge or by using Esko's barcode plug-in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will end in a warning.
Note: You cannot use this task to check and auto correct barcodes in normalized PDFs generated by ArtPro.

For Inks, you can select:

- **Auto Correct** when you want the task to correct attributes of the file's inks according what is specified in the job's inks tab on page 18.

- **Auto Correct (Strict Checking):** Same as ‘Auto Correct’ but now also the order of the inks is corrected (according the job's ink parameters).
  
  In this strict setting, the task will finish with an error if it finds unexpected inks (inks that are in the file, but not defined in the job parameters) and with a warning if it finds missing inks (inks that are not in the file but defined in the job parameters).

- **Stop with Error** when you want the task to stop with an error if the job's ink parameters are different than those in the file.

<table>
<thead>
<tr>
<th>Table: Some example situations when checking inks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing ink (ink specified in Job Parameters but not in file)</td>
</tr>
<tr>
<td>Wrong sequence of inks</td>
</tr>
<tr>
<td>Unexpected ink (ink in file which is not in Job Parameters)</td>
</tr>
</tbody>
</table>

8.5. The Remove Job Task

The **Remove Job** task serves to remove one or multiple jobs.

Tip: Learn more about what happens when jobs are removed in About Removing Jobs on page 48.

Using the Remove Job Task in a Workflow

This task needs a job as input. This is why, in a workflow, you typically use the workflow control Select Job in front of this task.
**Having Jobs Removed by an External System**

Any task can be launched by an external system. In workflows where jobs are created automatically through integration with an external system, that same system can also decide when to remove jobs. For example a business system triggers the **Remove Job** task right after it invoiced the job. Learn more in *Integrating with External Systems*.

**Only Removing the Job from the Database or also Removing the Files?**

You can choose to also **Delete the files and folders**. This will delete the whole job folder.

<table>
<thead>
<tr>
<th><strong>Note:</strong></th>
<th>In a workflow, when this option is active, the <strong>Remove Job</strong> task step does not have an output pin and so represents an end point for that workflow.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>When the files and folders were not deleted, you can later still recreate the removed job with the same job settings as before. To do this, select the ex-job folder and choose <strong>New Job</strong> or launch the task <strong>Restore Job</strong>.</td>
</tr>
</tbody>
</table>

**What about the Job's Tasks?**

As usual, when a job is removed, the **Task Cleanup Rules** are applied. These rules decide which tasks move to the **Task History** and which ones are deleted. After applying these task cleanup rules (if any), any remaining tasks of this job are deleted.
9. Automated Creation of Jobs

Most of the job setup parameters originate in another system, often the order entry part of the business system. It could also be a web-portal where job specifications were first entered.

When someone already entered this data manually, we advise to not re-enter that data. We therefore strongly advise to get your jobs created automatically.

The chapter *Integrating with External Systems* explains how this can be done. It describes the many available techniques and also offers exercises.

Here is a summary of how jobs can be created automatically:

- by the *Create Job task* that, as part of a workflow, picks up the job setup parameters via SmartNames or from an external (XML) file(s).

- by an *Access Point* that interacts with the external system and launches a workflow that uses the found information in the *Create Job* task.

- via JDF/JMF commands from an external system, sent directly to Automation Engine's JDF channel.